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2 SAFETY INSTRUCIONS

* Please read these safety precautions carefully before using the product.
¢ In this manual, the illustration may be somewhat different from your product because it is

just example to help the instruction.

N
A WARNING ° If you ignore the warning message, you may be seriously injured or there is a
possibility of accident or death.
A CAUTION - If you ignore the caution message, you may be slightly injured or the product may
be damaged. )

PRECAUTION IN INSTALLING THE PRODUCT
/\ WARNING

Keep away from heat sources like electrical )
heaters.
| - Electrical shock, fire, malfunction or
—=—=" deformation may occur.

)
Do not use the product in damp place such
as a bathroom or any place where it is likely
to get wet.
- This may cause a fire or could give an
electric shock.
J
N

If you can smell smoke or other odours or hear

a strange sound unplug the power cord and

contact the service center.

- If you continue to use without taking proper
measures, electrical shock or fire can occur. )

/\ CAUTION
-
]

Install the product on a flat and stable place
that has no risk of dropping the product.

- If the product is dropped, you may be injured
or the product may be broken.

AN

Keep the product away from direct sunlight.
- The product can be damaged.

7

AN

Do not place the product in a built-in
installation such as bookcase or rack.
- Ventilation required.

ELECTRICAL POWER RELATED
PRECAUTIONS

/\ WARNING
( 7 ié "= Make sure to connect the power cable to a
1

ﬁ properly earthed outlet.

J

- You may be electrocuted or injured.

AN

Do not touch the power plug with wet hands.
 Additionally, it the cord pin is wet or covered
with dust, dry the power plug completely or wipe
dust off.

- You may be electrocuted due to excess
moisture.

J

During a thunder or lightning storm, unplug the A
—, %, power cable or signal cable.

£ - You may be electrocuted or a fire can break
out.

/\ CAUTION

Protect the power cord from physical or
mechanical abuse, such as being twisted,
kinked, pinched, closed in a door, or walked
upon. Pay particular attention to plugs, wall
outlets, and the point where the cord exits
the appliance.

not disconnected from the AC power source even if you
turn off this unit by SWITCH.

[AS long as this unit is connected to the AC wall outlet, it is

J

PRECAUTIONS WHEN MOVING THE PRODUCT
/\ WARNING

-
Make sure to turn off the product.
Make sure to remove all cables before
moving the product.
- You may be electrocuted or the product
can be damaged.

/\ CAUTION

(" Do not impact the product when moving it. R
- You may be electrocuted or the product
can be damaged.

Make the panel face forward and hold it
with both hands to move.

- If you drop the product, the damaged
product can cause electric shock or fire.
Contact your nearest service center for

L repair. )
PRECAUTIONS WHEN USING THE PRODUCT
/\ WARNING

( Do not disassemble, repair or modify the
product at your own discretion.
- Fire or electric shock accident can occur.
- Contact the service center for check,
calibration or repair.

.

( To reduce the risk of fire or electric shock,
do not expose this apparatus to rain or
moisture.

Apparatus shall not be exposed to
dripping or splashing and no objects
filled with liquids, such as vases, shall be
placed on the apparatus.

.

(" Refer all servicing to qualified service
personnel. Servicing is required when

the apparatus has been damaged in any
way, such as power supply cord or plug

is damaged, liquid has been spilled or
objects have fallen into the apparatus, the
apparatus has been exposed to rain or
moisture, does not operate normally, or

L has been dropped.

f IMPORTANT INFORMATION TO PREVENT “IMAGE BURN l\
BURN-IN” ON YOUR TELEVISION SCREEN

- When a fixed image (e.g. logos, screen menus, video game,
computer display or teletext pages) is displayed on the
television for an extended period it can become permanently
imprinted on the screen. This phenomenon is known as “image
burn” or “burn-in”. Image burn is not covered under the
manufacturer’s warranty.

- In order to prevent image burn, avoid displaying a fixed
image on your television’s screen for a prolonged period (2 or
more hours for LCD, 1 or more hours for Plasma).

- Image burn can also occur on the letterboxed areas of
your television if you use the 4:3 aspect ratio setting for an
extended period.

&
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ASSEMBLING AND PREPARING

Unpacking

Check your product box for the following items. If there are any missing accessories, contact the local
dealer where you purchased your product.
The illustrations in this manual may differ from the actual product and item.

Remote control and batteries ~ Nero MediaHome 4 Essentials CD Owner’s manual
(AAA)
Polishing cloth’ Cleansing Cloths (Mitt)?
(Depending on model) (Depending on model)
4 y,

1 Gently wipe the spots on the cabinet with the polishing cloth.

2 Wipe spots on the exterior only with the cleansing cloths.
Do not wipe roughly when removing stains. Excessive pressure —
may cause scratches or discolouration. /(

For cleaning front frame, please slowly wipe in one direction
after spraying water 1-2 times on cleansing cloths. Please
remove excessive moisture after cleaning. Excessive moisture
may cause water stains on the frame.
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4  ASSEMBLING AND PREPARING

e )
Only 32/42/47LV37+*
I T
M4 x 12
Screw for assembly Screw for fixing Cable holder
(Only 32LV37**)

\ J
e N

=
g x8
M4 x 16
(Only 47/55LW95++)

T

M4 x 12

(Except for
47/55LW95++)

Magic Motion Remote
Control,
Strap, Batteries (AA)

(Only 47/55LW77++,
47/55L\W95++)

&

Screw for assembly

Composite gender cable Component gender cable

Only 32/37/42/47/55LV/55+*, 42/47TL\W57++, 42/47/55L W65+, 47/55LW77+*, 47/55L W95+«

|

Screw for fixing
(Only 32/37LV55++)

N

3D Glasses'
(AG-P110, AG-F110)
(Only 42/47L\W57+x,
42/47/55L\W65++)

Cable holder

3D Glasses (AG-S250)
(Only 47/55LW77++,
47/55LW95++)

1 The number of 3D glasses may differ depending on the country.
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p
Only 47/55L.296

e

.

Stand Base

X2

Display Link Cable
(stand type and wall
mounting type)

Wall Anchor

M4 x 7

Bolts for stand and wall mounting bracket assembly

Composite gender cable Component gender cable

Stand Body

>

Wall Mounting Bracket

(one for the set and one for
the wall)

M4 x 14

Magic Motion Remote
Control,
Strap, Batteries (AA)

3D Glasses (AG-S250) Cable holder

Stand Rear Cover

=

Wall Mounting Bracket
Pushpin

Display Link Cable Cover

x2

Set Protection Bracket
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6 ASSEMBLING AND PREPARING

/\ cAUTION

* Do not use any unapproved items to ensure the safety and product life span.
* Any damages or injuries by using unapproved items are not covered by the warranty.

,0 NOTE N

¢ The items supplied with your product may vary depending on the model.
¢ Product specifications or contents of this manual may be changed without prior notice due to upgrade
of product functions.

¢ For an optimal connection, HDMI cables and USB devices should have bezels less than 10 mm thick
and 18 mm width. (Depending on model)

m
z
()
I
7}
I

Additional information

Viewing the owner’s manual

The owner’s manual in PDF file format is supplied on the enclosed CD. Install the Adobe Acrobat Reader to
view the owner’s manual on your PC.

1 Insert the supplied CD.
The web page appears automatically.

Click Owner’s Manual on the web page.

View the owner’s manual.

0 NOTE

If the web page does not appear automatically, access My computer and then click LG and index.
html to view the owner’s manual.
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Separate purchase

Separate purchase items can be changed or modified for quality improvement without any notification.
Contact your dealer for buying these items.
These devices only work with compatible LG LED LCD TV.

e )
u [ i’ !
Wireless Media Box 3D Glasses 3D Glasses
(AN-WL100W) (AG-S230, AG-S250, AG-S270) (AG-P110, AG-F110)
(Except for 32/42/47LV37++) (Only 47/55LW77+x, 47/55L\W95++,  (Only 42/47LW57++, 42/47/55L\W65++)
47/55LZ296+*)
Wireless LAN for Broadband Magic Motion Remote Control
/DLNA Adaptor (AN-MR200)
(AN-WF100)
(Except for 47/55LW95+x)
\ J

Parts and buttons

¢ Image shown may differ from your TV.

~ @) NoTE N

e TV can be placed in standby mode in order to reduce the power consumption. And TV should be
turned off if it will not be watched for some time, as this will reduce energy consumption.

¢ The energy consumed during use can be significantly reduced if the level of brightness of the picture
is reduced, and this will reduce the overall running cost.

-
_/\ cAuTION N

* Do not step on the glass stand or subject it to any impact. It may break, causing possible injury from
fragments of glass, or the TV may fall.

* Do not drag the TV. The floor or the product may be damaged.
N J
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8  ASSEMBLING AND PREPARING

Only 42/47/55LW65+* 47/55LW95++

— Screen
Only 47/55LW95+*
P = OK® HOME INPUT /I I_
v A - + v H N [0)
Only 42/47/55L\W65+* Touch
buttons?
T v ~ — + v H N [0} I
- /\\D\:\ P A OK® HOME INPUT (/I |.

Remote control and intel-
ligent' sensors

Power indicator

USB Apps

USBIN 1oz USBIN2e<-

HDD IN

COMPONENT
IN1
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WIRELESS
CONTROL

A

A

HOmI/OVI HDmMI/DVI

— 03daINn —1
ad

XX XX )

LJ

<
5
2
o
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S
=
g
5

(30IA43SI0MIND) NI 0262:5Y
~olanva
1

|

HomI/DVI Homi/DVI

LAN

RGB IN (PC)

AUDIO IN
I

RGB/DVI Rear Connection panel

N J
Touch button? Description
O/ Turns the power on or off.
INPUT Changes the input source.
HOME Accesses the Home menu, or saves your input and exits the menus.
OK ® Selects the highlighted menu option or confirms an input.
- A+ Adjusts the volume level.
v Pa Scrolls through the saved programmes.

1 Intelligent sensor - Adjusts the image quality and brightness based on the surrounding environment.
2 All of the buttons are touch sensitive and can be operated through simple touch with your finger.

0 NOTE

* You can set the power indicator light to on or off by selecting OPTION in the Home menu - SETUP.




ASSEMBLING AND PREPARING 9

Only 32/37/42/4755LV55++

Screen

Remote control and intel-

\ ligent' sensors

T— Power indicator

Speakers
~ S - + v H N /1
P a OK® HOME INPUT '|— Touch buttons?
~
¥
a m
E z
7] ()
i 2
= (%)
@S T
i a ;
@ :
5 8
2 5 L 3 @ 3 E
8 c 7]
= — S I
g B % =
B g g a
= S g =
o -0®: E
I
AUDIOIN OPTICALDIGITAL ANTENNA/ Rear Connection
(RGB/DVI)
panel
___ ( _J
Touch button? Description
O/ Turns the power on or off.
INPUT Changes the input source.
HOME Accesses the Home menu, or saves your input and exits the menus.
OK ® Selects the highlighted menu option or confirms an input.
- A+ Adjusts the volume level.
v Pa Scrolls through the saved programmes.

1 Intelligent sensor - Adjusts the image quality and brightness based on the surrounding environment.
2 All of the buttons are touch sensitive and can be operated through simple touch with your finger.

0 NOTE

* You can set the power indicator light to on or off by selecting OPTION in the Home menu - SETUP.
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Only 42/47LW57+ AT[S5LWT7++

— Screen

|

1

— Buttons

EERIERE]

|

Speakers Remote control and intelligent’

sensors, Power indicator
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LAN

(30IA43S104INOD) NI 92254

RGB IN (PC) AUDIOIN OPTICAL DIGITAL - ANTENNA/

USB Apps

USBIN fecz» USBIN2e<e

HDDIN

| COMPONENT
col \NO1

WIRELESS
CONTROL

A

A
HDomI/OVi HomI/DVI

— 03dIAN T
ad

¥d

®
®
®
®

©

—olanva

-@

HDOMI/DVI HDMmMI/DVI

IN 1(ARC)

i Rear Connection panel

®

RGB/DVI) AUDIOOUT ~ CABLEIN

@@

Button

Description

O/

Turns the power on or off.

INPUT

Changes the input source.

HOME

Accesses the Home menu, or saves your input and exits the menus.

OK ®

Selects the highlighted menu option or confirms an input.

- A+

Adjusts the volume level.

vPa

Scrolls through the saved programmes.

1 Intelligent sensor - Adjusts the image quality and brightness based on the surrounding environment.

0 NOTE

* You can set the power indicator light to on or off by selecting OPTION in the Home menu - SETUP.
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Only 32/42/47LV 37 **
— Screen

Remote control and intel-
\ ligent' sensors
% ) Power indicator
:pmke\\])

v P oA _ a4+ OK® HOME INPUT '—J— Touch buttons?
Except for 32/42/47LV370S Only 32/42/47L.V370S
AN AUDIOINRGBDY) LAN _ AUDIOINRGBDV)

) [ - iy B b

OPTICALDIGITAL RGB IN (PC) OPTICAL DIGITAL RGB IN (PC)

@ @
@ @ AUDIO OUT RSBZC\N (CONTROL & SERVICE)

AUDIOOUT  RS-232CIN (CONTROL & SERV\CE)

CIok
@. %
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8d

3d

®©®
@®®
N ¥oxo

—O03aA—,
EHoIanvEEIE 03aIA

~01aNv,

ANTENNA/ CABLE IN

13/18V =

700mA Max @ ANTENNA
LNB IN / CABLE IN
Satellite

o

|

Rear Connection panel

Touch button? Description
G/ Turns the power on or off.
INPUT Changes the input source.
HOME Accesses the Home menu, or saves your input and exits the menus.
oK ® Selects the highlighted menu option or confirms an input.
A+ Adjusts the volume level.
Vv Pa Scrolls through the saved programmes.

1 Intelligent sensor - Adjusts the image quality and brightness based on the surrounding environment.
2 All of the buttons are touch sensitive and can be operated through simple touch with your finger.

0 NOTE

* You can set the power indicator light to on or off by selecting OPTION in the Home menu - SETUP.
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12 ASSEMBLING AND PREPARING

Only 47/55LZ296++

— Screen

a OK® HOME INPUT /I
A -+ v H N 0]

—_— Speakers
l \

1

Power indicator and ligent' sensors
Touch buttons?

Remote control and intel-

USB Apps m
D a1 wsowr[M] QL0 [7]
g DISPLAY LINK = Ham ResNre (&?M)
oot eshes = © womnsn
1(ARC)ILa =Ly i [INIE 2

Rear Connection panel

Button Description
O/ Turns the power on or off.
INPUT Changes the input source.
HOME Accesses the Home menu, or saves your input and exits the menus.
OK ® Selects the highlighted menu option or confirms an input.
- A+ Adjusts the volume level.
v PA Scrolls through the saved programmes.

1 Intelligent sensor - Adjusts the image quality and brightness based on the surrounding environment.
2 All of the buttons are touch sensitive and can be operated through simple touch with your finger.

0 NOTE

* You can set the power indicator light to on or off by selecting OPTION in the Home menu - SETUP.
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Lifting and moving the TV

When moving or lifting the TV, read the following to
prevent the TV from being scratched or damaged
and for safe transportation regardless of its type
and size.

/\ cAuTION

 Avoid touching the screen at all times, as this
may result in damage on the screen.

¢ |tis recommended to move the TV in the box
or packing material that the TV originally came
in.

» Before moving or lifting the TV, disconnect the

power cord and all cables.

When holding the TV, the screen should face

away from you to avoid damage.

Hold the top and bottom of the TV frame firmly.
Make sure not to hold the transparent part,
speaker, or speaker grill area.

* When transporting a large TV, there should be
at least 2 people.

* When transporting the TV by hand, hold the
TV as shown in the following illustration.

e When transporting the TV, do not expose the
TV to jolts or excessive vibration.

e When transporting the TV, keep the TV
upright, never turn the TV on its side or tilt
towards the left or right.

Setting up the TV

Put your TV on a pedestal stand and mount the TV
on a table or wall.

Attaching the stand

If you are not mounting the TV to a wall, use the
following instructions to attach the stand.

Only 47/55LW95+«

1 Lay the TV with the screen side down on a flat
surface.

/\ cauTION

» Lay a foam mat or soft protective cloth on the
surface to protect the screen from damage.
Make sure no objects press against the
screen.

2 Assemble the parts of the Stand Body with the
Stand Base of the TV.

Screw for assembly |Number of screws

M4 x 16 4

Stand Body

Stand Base

3 Assemble the parts of the Stand Rear Cover
with the TV.

4 Secure the TV and the stand with the 4 screws.

Screw for assembly Number of screws

M4 x 16 4

* Tighten the screws firmly to prevent the TV
from tilting forward. Do not over tighten.

Stand Rear Cover
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14 ASSEMBLING AND PREPARING

Only 32/42/47LN37++, 32/37/42/47/55LV 55+,
42/4TLWST7+*, 42/47/55LW65** 47/S5LWT 7+

1 Lay the TV with the screen side down on a flat

surface.

A CAUTION

¢ Lay a foam mat or soft protective cloth on the
surface to protect the screen from damage.
Make sure no objects press against the

screen.

2 Assemble the parts of the Stand Body with the

Stand Base of the TV.

Screw for assembly

Number of screws

M4 x 12

4

Stand Body

Stand Base

3 Secure the TV and the stand with the 4 screws.

Screw for assembly

Number of screws

M4 x 12

4

¢ Tighten the screws firmly to prevent the TV
from tilting forward. Do not over tighten.

Only 47/55L.296**

1 Place the stand base facing down on a table
or flat surface. Assemble the Stand Body with
the Stand Base using the screws provided

with the TV set.

Screw for assembly

Number of screws

M4 x 7

Stand Body

damage.

the TV set.

Carefully place the TV screen side down on a
cushioned surface to protect the screen from

Mount the stand to the TV set fitting into
grooves in direction of the arrows as shown in
the figure. Have the TV set align with the holes
for inserting screws. Assemble the Stand Body
with the TV set using the screws provided with

Screw for assembly

Number of screws

M4 x 14
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4 Use the Display Link Cable (for stand; the
shorter one) to connect the Stand Base and
the display link input on the TV. After connec-
tion, fasten the screws with a driver to mount
the cable tightly.

6 Place the Display Link Cable Cover and con-
nect it with the Stand Body using the screws
provided with the TV set.

Screw for assembly |Number of screws

M3 x 6 4

* Tighten the screws firmly to prevent the TV
from tilting forward. Do not over tighten.

Mounting on a table

1 Lift and tilt the TV into its upright position on a
table.
- Leave a 10 cm (minimum) space from the
wall for proper ventilation.

Except for 47/55LZ96+«

2 Connect the power cord to a wall outlet.

/\ CAUTION

* Do not place the TV near or on sources of
heat, as this may result in fire or other dam-
age

p 0 NOTE N

Except for 47/55L296+**
» Swivel 20 degrees to the left or right and
adjust the angle of the TV to suit your
view.
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16 ASSEMBLING AND PREPARING

Securing the TV to a table Securing the TV to a wall
(This feature is not available for all models.)

(Only 32/37LV55+*, 32LV37**)

Fix the TV to a table to prevent from tilting forward,
damage, and potential injury.

Mount the TV on a table, and then insert and
tighten the supplied screw on the rear of the stand.

1 Insert and tighten the eye-bolts, or TV brackets
and bolts on the back of the TV.

- If there are bolts inserted at the eye-bolts

WARNING position, remove the bolts first.
* To prevent TV from falling over, the TV 2 Mount the wall brackets with the bolts to the
2 should be securely attached to the floor/wall wall.
8 per installation instructions. Tipping, shaking, Match the location of the wall bracket and the
0
I

or rocking the TV may cause injury. eye-bolts on the rear of the TV.

3 Connect the eye-bolts and wall brackets tightly
with a sturdy rope.

Make sure to keep the rope horizontal with the
flat surface.

_/\ cAuTION N

¢ Make sure that children do not climb on or

hang on the TV.
N J

0 NOTE ~

* Use a platform or cabinet that is strong and
large enough to support the TV securely.

- J
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Mounting on a wall

Attach a wall mount bracket at the rear of the TV Bi
carefully and install the wall mount bracket on a : |
solid wall perpendicular to the floor. When you
attach the TV to other building materials, please
contact qualified personnel.
LG recommends that wall mounting be performed

_/\ cAuTION

by a qualified professional installer. ~
* Disconnect the power first, and then move or
install the TV. Otherwise electric shock may
occur.
* If you install the TV on a ceiling or slanted
wall, it may fall and result in severe injury.
Use an authorized LG wall mount bracket
and contact the local dealer or qualified
personnel.
* Do not over tighten the screws as this may
cause damage to the TV and void your war-
ranty.
* Use the screws and wall mount bracket that
meet the VESA standard. Any damages or
injuries by misuse or using an improper ac- m
Make sure to use screws and wall mount bracket cessory are not covered by the warranty. z
that meet the VESA standard. Standard dimen- @
sions for the wall mount kits are described in the )
. - ) T
following table.
- 0 NOTE ~
el e e el Lt T [ GG * Use the screws that are listed on the VESA
Model 32LV37++, 37LV S5+ standard screw specifications.
32LV55++ * The wall mount kit includes an installation
\s,ESnAd:;xszzew 3040 x 100 f/IOGO x 200 manual and necessary parts. .
Number of screws |4 4 * The length of screws may differ depending
Wall mount LSW100B, LSW200B, on the wall mount. Make sure to use the
bracket LSW100BG LSW200BG proper length.
= ¢ For more information, refer to the manual
Ele _ supplied with the wall mount bracket.
e = L J

Model 42/4T7LN 37 **, 42/47/55LV55+*,
42/47/55LW65++, 42/4TLW57 *+,
A7/55L W77+, 47/55LW9Q5++,
47/551. 296+«

VESA (A x B) 400 x 400

Standard screw  |M6

Number of screws |4
Wall mount LSW400B, LSW400BG,
bracket DSW400BG
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18 ASSEMBLING AND PREPARING

Wall mounting bracket installa-
tion

Only 47/55LZ296++

1 Carefully place the TV screen side down on a

cushioned surface to protect the screen from
damage.

2 Fasten the screws to mount the Wall Mount-
ing Bracket for the set and the Set Protection
Brackets to the TV set.

Screw for assembly |Number of screws

M4 x 7 2
M4 x 14 2

3 Mount the Wall Mounting Bracket to the place

you want using the Wall Anchors and Screws
as shown below. You can adjust the level of the
Wall Mounting Bracket with the level gauge
attached.

@

(@

3-1Drill holes with depth of 80 mm - 100 mm at
the anchor location with a 8 mm drill bit.

MANNNNNNNN

3-2Clean the drilled holes.

3-3Insert the Wall Anchor provided in the hole.

3-4Push the Wall Mounting Bracket to the walll
aligning with the hole. Make sure that the angle
adjusting knob is located on the upper side of
the Wall Mounting Bracket.

3-5Screw the Screw for the Wall Mounting
Bracket into the hole. At this time, fasten the
Screw applying a torque of at least 45 kgfecm.
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0 NOTE ~

¢ Check the material of the wall and thickness
of finishing material.

* You can use the anchors and screws pro-
vided with the TV set for the wall made with
concrete, lightweight concrete, soft field-
stone, hard fieldstone, brick or cellular block.

¢ Do not mount on the wall made with plaster
board or medium density fibreboard (MDF).
In this case, the anchor and screws must be
inserted in the concrete inside of finishing
material. If there is no concrete inside, you
must install a separate hanger first and fix
the anchors and screws.

* For other cases, make sure that each fixed
part can resist the pull-out load of 70 kgf
(686 N) and shear load of 100 kgf.

4 Connect the Display Link Cable (for wall
mounting bracket; the longer one) to the
display link input on the back of the TV. Then,
mount the TV set on the wall in direction of the
arrow as shown in the figure.

/

7/
5 Secure the set with the Wall Mounting
Bracket Pushpins.

Wall Mounting
Bracket Pushpin

6 Place the Stand Base in a proper location and
connect it with the Display Link Cable.

Tidying cables

Only 32/42/47LNV 37+ 32/37/42/47/55LV 55+,
42/47LWSET =, 42/4T7/55LW65+*, 47/55LW77**

1 Gather and bind the cables with the Cable

Cable Holder

Only 47/55LW95+=«

1 Gather and bind the cables with the Cable
Holder .

ITIY

l

Cable Holder

Only 47/55L296**

1 Secure the power cord with the Cable Holder
on the TV back cover. It will help prevent the
power cable from being removed by accident.

\H%;. - _;[D:H
mall

2 After connecting the cables as necessary,
install Cable Holder as shown and bundle the
cables.

e [
I

=a——
./— Cable Holder
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20 REMOTE CONTROL

REMOTE CONTROL

The descriptions in this manual are based on the buttons on the remote control.
Please read this manual carefully and use the TV correctly.

To replace batteries, open the battery cover, replace batteries (1.5 V AAA) matching
@ and O ends to the label inside the compartment, and close the battery cover. Be
sure to point the remote control toward the remote control sensor on the TV.

To remove the batteries, perform the installation actions in reverse.

/\ CAUTION

* Do not mix old and new batteries, as this may damage the remote control.
* In Analogue TV and some countries, some remote control keys may not work.

¢ Image shown may
differ from your TV.

&(POWER) Turns the TV on or off.

ENERGY SAVING Adjusts the brightness of the screen to reduce energy
consumption .

AV MODE Selects an AV mode.

INPUT Changes the input source; Turns the TV on .

TV/IRAD Selects Radio, TV and DTV programme.

Alphanumeric but-
tons

Enters letters and numbers.

LIST Accesses the saved programme list.

Q.VIEW Returns to the previously viewed programme.
A+- Adjusts the volume level.

MARK Selects a menu or option.

FAV Accesses your favourite programme list.
CHAR/NUM Switches between Letter and Number input modes.
3D Used for viewing 3D video.

RATIO Resizes an image.

DELETE Deletes letters and numbers.

MUTE Mutes all sounds.

PA v Scrolls through the saved programmes.

PAGE Moves to the previous or next screen.

Premium Accesses the Premium menus.

Home Accesses the Home menus.

Q. MENU Accesses the quick menus.

3D OPTION Used for viewing 3D video.

Navigation buttons |Scrolls through menus or options.
(up/down/left/right)

OK Selects menus or options and confirms your input.
BACK Returns to the previous level.

GUIDE Shows programme guide.

INFO Views the information of the current programme and screen.
EXIT Clears all on-screen displays and return to TV viewing.

Coloured buttons

These access special functions in some menus.

TELETEXT BUTTONS

These buttons are used for teletext.
For further details, see the ‘Teletext’ section.

SUBTITLE

Recalls your preferred subtitle in digital mode.

Control buttons
(m > 1l <4 >P)

Controls the Premium contents, DVR or Smart Share menus or
the SIMPLINK compatible devices (USB or SIMPLINK or DVR).

LIVE TV Return to LIVE TV.
REC Use to adjust DVR menu.
SIMPLINK Accesses the AV devices connected to the TV,

Opens the SIMPLINK menu.
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Magic Motion Remote Control Functions

This item is not included for all models.

32/42/47L\V37+*, 32/37/42/47/55LV55+*, 42/4TL\W57*, 42/47/55LW65+** : Supports the
Magic Motion remote control, which is sold separately. Refer to the Magic Motion Re-
mote Control manual for operating instructions.

Please read this manual carefully and use the TV correctly.
When the message "Magic motion remote control battery is low. Change the battery." is

displayed, replace the battery. ’
To replace batteries, open the battery cover, replace batteries (1.5 V AA) matching @

and © ends to the label inside the compartment, and close the battery cover. Be sure to N
point the remote control toward the remote control sensor on the TV. 1]

To remove the batteries, perform the installation actions in reverse.

/\ CAUTION

* Do not mix old and new batteries, as this may damage the remote control.
* In Analogue TV and some countries, some remote control keys may not work.

m
_ Pointer (RF transmitter) Zz
- Blinks the light when operating. 9
7
¢ (POWER) —@ I
Turns the TV on or off. - Home
HAfe Accesses the Home menus.

® Navigation buttons
oK (up/down/left/right)

. ) OK O Scrolls through menus or options.

Selects menus or options and confirms your

input.

Press this button to display the pointer when

it disappears from the screen. You can

control the TV by selecting Quick Menu on

the screen. A+ -
- If you press the Navigation button while Adjusts the volume level.
moving the pointer on the screen, the PAv
pointer disappears, and the Magic Motion Scrolls through the saved pro-
remote control works as a common remote grammes.
control.
To display the pointer again, shake the
Magic Motion remote control from side to
side within 2 minutes after it disappeared.
(If 2 minutes have passed, press the OK
button to display the pointer.) MUTE
Mutes all sounds.
g
3] %
re===== a
| 1) Home menu| ‘EEE Programme Lislm k3D m@ Quick Msnu‘

Only 3D models
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Registering Magic Motion Re-
mote Control

The Magic Motion Remote Control operates by
pairing with your TV.
Register the Magic Motion Remote Control to use.

How to register the Magic Motion Remote Con-
trol

To register the remote control, press the OK button
on the remote control while aiming it at your TV.

How to Re-register the Magic Motion Remote
Control after Registration Failure

Reset the remote control by pressing and holding
both the OK and MUTE buttons for 5 seconds.
(Once the reset is complete, the light on the
Pointer blinks.) Then repeat the above procedure
to register the remote control.

How to use Magic Motion Re-
mote Control

1 Press OK button if there is no pointer on your
TV screen. The pointer will then appear on the
screen.

If the pointer has not been used for a certain
period of time, it will disappear.

2 You can move the pointer by aiming the Pointer
Receiver of the remote control at your TV then
move it left, right, up or down.

If the pointer does not work properly after click-

ing the OK button, leave the remote control for
10 seconds then use it again.

Precautions to Take when Using
the Magic Motion Remote Control

¢ Use the remote control within the maximum
communication distance (10 m). Using the
remote control beyond this distance, or with
an object obstructing it, may cause a com-
munication failure.

¢ A communication failure may occur due to
nearby devices. Electrical devices such as
a microwave oven or wireless LAN product
may cause interference, as this will use the
same bandwidth (2.4 GHz) as the Magic Mo-
tion Remote Control.

* The Magic Motion Remote Control may be
damaged or may malfunction if it is dropped
or receives a heavy impact.

* When playing a game using the Magic
Motion Remote Control, hold it securely by
wrapping its strap around your wrist and
adjusting the length with the adjustable ring.

» Take care not to bump into nearby furniture
or other people when using the Magic Motion
Remote Control.

e Manufacturer and installer cannot provide
service related to human safety as the ap-
plicable wireless device has possibility of
electric wave interference.

* It is recommended that an Access Point
(AP) be located more than 1 m away from
the TV. If the AP is installed closer than 1
m, the magic motion remote control may
not perform as expected due to frequency
interference.

s
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WATCHING TV

Connecting to an antenna

Connect an antenna to watch TV while referring to
the following.

To prevent damage do not connect to the mains
outlet until all connections are made between the
devices.

Connecting an antenna

Connect the TV to a wall antenna socket with an
RF cable (75 Q).

0 NOTE ~

» Use a signal splitter to use more than 2
TVs.

« If the image quality is poor, install a signal
amplifier properly to improve the image
quality.

« If the image quality is poor with an
antenna connected, aim the antenna to
the correct direction.

¢ An antenna cable and converter are not
supplied.

_ /

Turning the TV on for the
first time

When you turn the TV on for the first time, the
Initial setting screen appears. Select a language
and customize the basic settings.

1 Connect the power cord to a power outlet.

2 In Standby mode, press (h(POWER) to turn
the TV on.

The Initial setting screen appears if you turn
the TV on for the first time.

0 NOTE

* You can also access Factory Reset by
accessing OPTION in the Home menu -
SETUP.

3 Follow the on-screen instructions to customize

your TV settings according to your preferences.

| Language | Selects a language to display.
(Except for Australia, New
4 Zealand, Singapore, South

Africa),

Mode Setting | Selects Home Use for the

Iyl Home environment.

Power Indicator | Sets the power indicator.

(When you select Home Use

3 from Mode Setting - only LED
LCD TV)
| Country | Selects a country to display.
g (Only Australia, New Zealand)
| Time Zone | Selects the time zone and day-
3 light saving.(Only Australia)

Network Setting | Sets your network to enable

network-related feature on the
4 TV.(Only 47/55LW95x+)

Auto Tuning | Scans and saves available

- )

,o NOTE N

channels automatically.

e DTV mode control buttons may not
function based on country broadcasting
circumstances.(Only DTV)

 For those countries without confirmed

DTV broadcasting standards, some DTV

features might not work, depending on

the DTV broadcasting environment.(Only

DTV)

To display images in the best quality for

your home environment, select Home

Use.

» Store Demo is suitable for the retail

environment.

If you select Store Demo, the any

customized settings will switch back to

the default settings of Store Demo in 5

minutes.

4 When the basic settings are complete,
press OK.

0 NOTE

* If you do not complete the Initial setting, it
will appear whenever the TV turns on.

* Disconnect the power cord from the
power outlet when you do not use the TV
for a long period of time.

5 To turn the TV off, press (')(POWER).
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24 WATCHING TV

Accessing Home menu

1 Press Home to access the Home menu.

2 Press the Navigation buttons to scroll to one of the following menus and press OK.

3 Press the Navigation buttons to scroll to the setting or option you want and press OK.

4 When you are finished, press EXIT.

En
" New
o N UCC Service E—S”
2 B =

Photo Album r
@ — e iy INPUT H Social Network Service L 3 ﬁ
! [}

(1] 0 6 (4] (5] (6]
I I W S
e o facn sttt el |

remium LG Apps

Hot

&

©

oK
X
Ve

Movie Online Unit convertor Puzzle

Weather Info

=
National-lag | Horoscope

Mah-Jong Winesound

»
N _____=

LG Apps Web Browser Media Link Arrow

Description

Current Date, Time

Channel programme info

Function card: You can enjoy various content files by selecting each card.

Function card position

Sign In

Exit

Current watching channel screen

Enter INPUT, SETUP, GUIDE or FAVOURITE menu. GUIDE menu may be changed to
FAVOURITE based on country broadcasting circumstance.

® o996 O0®eQP

Launcher bar
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ENTERTAINMENT

Network Connection

Connecting to a wired network

Connect the TV to a local area network (LAN) via
the LAN port as shown in the following illustration
and set up the network settings.

If wired and wireless networks are both available,
wired is the preferred method.

After making a physical connection, a small
number of home networks may require the TV
network settings to be adjusted. For most home
networks, the TV will connect to automatically
without any adjustments.

For detail information, contact your internet pro-
vider or router manual.

@ ETHERNET
e Cable modem U

Internet

_/\ cAuTION

* Do not connect a modular phone cable to the
LAN port.

 Since there are various connection meth-
ods, please follow the specifications of your
telecommunication carrier or internet service
provider.

» After connecting the LAN port, use the
Premium or LG Apps menu.

&

N

To set up the network settings: (Even if your TV
has already connected automatically, running
setup again will not harm anything),

1 Press Home to access the Home menu.

Press the Navigation buttons to scroll to
SETUP and press OK.

3 Press the Navigation buttons to scroll to NET-
WORK and press OK.

4 Press the Navigation buttons to select Net-
work Setting and press OK.

5 If wired and wireless are simultaneously con-
nected, press the Navigation buttons to select
Wired and press OK.

6 If you have already set the Network Setting,
select Resetting. The new connection settings
will reset the current network settings.

7 Select IP Auto Setting or IP Manual Setting.

- If selecting IP Manual Setting, press the
Navigation and Number buttons. IP address-
es will need to be input manually.

- IP Auto Setting: Select this if there is a
DHCP server(Router) on the local area
network (LAN) via wired connection, the TV
will automatically be allocated an IP address.
If you're using a broadband router or broad-
band modem that has a DHCP (Dynamic
Host Configuration Protocol) server function.
The IP address will automatically be deter-
mined.

- IP Manual Setting: Select if there is no
DHCP server on the network or you want to
set the IP address manually.

8 When you are finished, press EXIT.

,0 NOTE N

* If you want to access the Internet directly on
your TV, the broadband internet connection
should always be on.

* If you cannot access the Internet, check
the network conditions from a PC on your
network.

* When you use Network Setting, check the
LAN cable or check if the DHCP in the router
is turned on.

¢ If you do not complete the network settings,
the network may not work properly.
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26 ENTERTAINMENT

Connecting to a wireless net-
work

(Except for 32/42/47LV37+*)

The LG Wireless LAN for Broadband/DLNA Adap-
tor, which is sold separately, allows the TV to con-
nect to a wireless LAN network.

The network configuration and connection method
may vary depending on the equipment in use

and the network environment. Refer to the setup
instructions supplied with your access point or
wireless router for detailed connection steps and
network settings.

Setting up the AP (Access Point) or the wireless
router is required before connecting the TV to the
network. The easiest method is the WPS button
method (Third method in this section).

(Only 47/55LW95++ : Built-in the Wi-Fi Module,
Unnecessary Wireless LAN for Broadband/DLNA
adaptor setup)

@ ETHERNET
s Cable modem

(OXOXNO] Internet

d

,0 NOTE N

* For enjoying pictures, music or video stored
on a PC using the router, a wired connection
is recommended.

¢ When the wireless port of the router is used,
there may be restrictions on some functions.

¢ Itis recommended that an Access Point
(AP) be located more than 1 m away from
the TV. If the AP is installed closer than 1
m, the magic motion remote control may
not perform as expected due to frequency
interference.

To set up the network settings,

Press Home to access the Home menus.

2 Press the Navigation buttons to scroll to
SETUP and press OK.

3 Press the Navigation buttons to scroll to NET-
WORK and press OK.

4 Press the Navigation buttons to select Net-
work Setting and press OK.

5 Press the Navigation buttons to select Wire-
less and press OK.

6 If you already set Network Setting, select Re-
setting and press OK.
The new connection settings resets the current
network settings.

7 Press the Navigation buttons to select Setting
from the AP list and press OK.
- Scan the all available AP (Access Point) or
wireless routers within range and display
them as a list.

Selecting the wireless network setting type

Select the wireless network setting type.

Setting from the AP list

‘ Simple setting (WPS-button mode) ‘

‘ Setting Ad-hoc network ‘

@® Next

‘ J® Previous ‘ ‘ D Exit ‘

8 Press the Navigation buttons to select an AP
(Access Point) or wireless router on the list. (If
your AP is secured, you will prompted for the
key.) and press OK.

Selecting AP
Select AP you want to connect.
Page 11
Input the new SSID
liptime FET
[asw | _
Access Point
‘Network1 (=] ‘ Search
‘ m PIN ‘ ‘ @® Connect ‘

9 Press the Number buttons to Input the security
key of AP and press OK.
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When a security code is already
set

PIN (Personal Identification Number)

If your router is set to use a PIN, use the following

instructions.

1

5 Repeat step 6-7 on “Connecting to a wired
network”.

Repeat step 1-7 on “Connecting the wireless
network”.

Press the Red button to connect the access
point with PIN mode.

You can see the Network ID and Security Key
on your TV screen.

Enter the PIN number to your device.
PIN number is the unique 8 digit number of the
dongle.

Press OK to select Connect.

Connecting with PIN mode

Insert PIN number at the AP webpage and
press 'Connect' button.

‘ PIN NUMBER : 12345670 ‘

For more information, check the AP manual.

@® Next

WPS (Wi-Fi Protected Setup)

If your router or AP has a WPS button, it is the
easiest connection method. You simply press the
button on the router and then select the WPS on
the TV within 120 seconds.

1 Repeat step 1-7 on “Connecting to a wireless
network”.

2 Press the Navigation buttons to select the
Simple setting (WPS-button mode).

Press the WPS button on your router.
Go back to the TV and select Connect.

Repeat step 6-7 on “Connecting to a wired
network”.
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28 ENTERTAINMENT

Ad-hoc Mode

Ad-hoc mode allows the TV to use a wireless to
connect to a computer without using a router or ac-
cess point.

1 Repeat step 1-5 on “Connecting to a wireless
network”.

2 Press the Navigation buttons to select Setting
Ad-hoc network and press OK.

3 Press the Navigation buttons to select OK and
press OK.

4 Press OK to select Connect to connect Ad-hoc

network.

- You can see the Network ID and Security Key
on your TV screen.

- Enter this Network ID and Security Key to
your device.

- When needed, you can change the setting
information using the Red button.

,0 NOTE N

When searching for wireless networks on

your PC using ad-hoc, the TV is named

LGTV10.

¢ LGTV10 that appears in the list. (Select
the same name as the network ID that
appears on your TV screen.)

5 Press the Navigation buttons to type in an IP
address and press OK.

Option Description

¢ Internet Protocol(TCP/IP) of PC
needs to be set manually. IP ad-
dress, Subnet Mask, and default
Gateway can be set with your own

PC Setting

discretion.
» e.g.) IP address: 192.168.0.1 /

Subnet Mask: 255.255.255.0 /
default Gateway: 192.168.0.10

* Verify IP address and gateway of
PC. Input Gateway address of PC
to IP Address, and IP Address of

PC to Gateway, and select OK.
» e.g.) IP address: 192.168.0.10

/ Subnet Mask: 255.255.255.0 /
default Gateway: 192.168.0.1

TV Setting

6 Press the Navigation buttons to select Close
after Network setting is completed.

7 Press the OK.
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Tips for Network setting

Use a standard LAN cable with this TV. Cat5 or
better with a RJ45 connector.

Many network connection problems during set
up can often be fixed by re-setting the router or
modem. After connecting the player to the home
network, quickly power off and/or disconnect the
power cable of the home network router or cable
modem. Then power on and/or connect the
power cable again.

Depending on the internet service provider
(ISP), the number of devices that can receive
internet service may be limited by the applicable
terms of service. For details, contact your ISP.
LG is not responsible for any malfunction of the
TV and/or the internet connection feature due

to communication errors/malfunctions associ-
ated with your broadband internet connection, or
other connected equipment.

LG is not responsible for problems within your
internet connection.

Some content available through the network
connection may not be compatible with the TV. If
you have questions about such content, please
contact the producer of the content.

You may experience undesired results if the
network connection speed does not meet the
requirements of the content being accessed.
Some internet connection operations may not
be possible due to certain restrictions set by the
Internet service provider (ISP) supplying your
broadband Internet connection.

Any fees charged by an ISP including, without
limitation, connection charges are your respon-
sibility.

A 10 Base-T or 100 Base-TX LAN port is re-
quired when using a wired connection to this TV.
If your internet service does not allow for such a
connection, you will not be able to connect the
TV.

A DSL modem is required to use DSL service
and a cable modem is required to use cable mo-
dem service. Depending on the access method
of and subscriber agreement with your ISP, you
may not be able to use the internet connection
feature contained in this TV or you may be lim-
ited to the number of devices you can connect at
the same time. (If your ISP limits sub-scription to
one device, this TV may not be allowed to con-
nect when a PC is already connected.)

The use of a “Router” may not be allowed or its
usage may be limited depending on the policies
and restrictions of your ISP. For details, contact
your ISP directly.

The wireless network operates at 2.4 GHz
radio frequencies that are also used by other
household devices such as cordless telephone,
Bluetooth® devices, microwave oven, and can
be affected by interference from them.It can

be interrupted by the device using 5 Ghz radio
frequencies. It is same device with LG wire-
less media box, cordless telephone, other Wi-Fi
device.

It may decrease the service speed using Wire-
less network by surrounding wireless condition.
Turn off all unused network equipment in your
local home network. Some devices may gener-
ate network traffic.

In some instances, placing the access point or
wireless router higher up away from the floor
may improve the reception.

The reception quality over wireless depends on
many factors such as type of the access point,
distance between the TV and access point, and
the location of the TV.

To connect wireless AP, an AP that supports the
wireless connection is necessary, and the wire-
less connection function of the AP needs to be
activated. Please enquire to the AP supplier for
the possibility of AP wireless connections.
Please verify the security settings of AP SSID for
wireless AP connection, and enquire to the AP
supplier for the AP SSID security settings.

The TV can become slower or malfunction with
wrong settings of network equipments (wired/
wireless router, hub, etc). Please install correctly
by referring to the manual of the equipment, and
set the network.

When AP is set to include 802.11 n, and if
Encryption is designated as WEP(64/128bit) or
WPA(TKIP/AES), the connection may not be
possible. There may be different connection
methods according to the AP manufacturers.
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Premium Account Function

LG’s Premium technology allows you to access a
variety of online services or contents directly on
your TV. Your TV offers instant streaming of mov-
ies, weather, videos, and photo album services
with a Premium account and an Internet connec-
tion.

Enjoy entertainment including not only entertain-
ment content, but also up-to-the minute news,
weather updates, photo management, and more
by simply using the TV’s remote control without a
separate PC.

1 Press Premium to access the Premium option.
2 Press the Navigation buttons to scroll to the

content you want and press OK.

6 6 o

- Sign In

i Retun Exit

= R

Social

Movie | Weather Info | Photo Album §  Network

Service Online N
Service

Sports
Service

Video
Streaming

Description

Moves to the weather setting screen.

Sign into the premium service.

Moves to the previous menu screen.

Returns to TV viewing.

Qo0 e

Selects your desired online service.

* |f a service requires you to log in, you
must first sign up for the service on your
computer and then log into the service
on the TV.

@ |Launcher bar

3 Enjoy the premium features.

Notice

These services are provided by separate
content provider.

Please visit the content providers' web site
for specific information on their service.
Premium menu can differ by country.

Note that content may be updated automati-
cally depending on the service provider, so
the content layout or operation method may
change without notice. Please refer to the
help menu on the screen.

All information, data, documents, communi-
cations, downloads, files, text, images, pho-
tographs, graphics, videos, webcasts, pub-
lications, tools, resources, software, code,
programmes, applets, widgets, applications,
products and other content (“Content”)

and all services and offerings (“Services”)
provided or made available by or through
any third party (each a “Service Provider”) is
the sole responsibility of the Service Provider
from whom it originated.

The availability of and access to Content
and Services furnished by the Service
Provider through the LGE Device are subject
to change at any time, without prior notice,
including, but not limited to the suspension,
removal or cessation of all or any part of the
Content or Services.

Should you have any inquiry or problem
related to the Content or Services, you may
refer to the Service Provider’s website for
the most up-to-date information. LGE is
neither responsible nor liable for customer
service related to the Content and Services.
Any question or request for service relating
to the Content or Services should be made
directly to the respective Content and Serv-
ice Providers.

Please note that LGE is not responsible for
any Content or Services provided by the
Service Provider or any changes to, removal
of, or cessation of such Content or Serv-
ices and does not warrant or guaranty the
availability of or access to such Content or
Services.

Some content may be harmful to minors
depending on the service provider. Parental
guidance is necessary.

The service may be interrupted if the Internet
connection is unstable. Please check the
connection status if you experience this
problem.



ENTERTAINMENT 31

* The videos list searched from the TV may
different with the list searched from a web
browser on PC.

* The playback of videos may pause, stop, or
buffer depending on your broadband speed.

» For service that requires log in, join the ap-
plicable service on the website using a PC
and log in through the TV to enjoy various
additional functions.

Legal Notice

IMPORTANT NOTICE RELATING TO NETWORK
SERVICE

All content and services accessible through this
device belong to third parties and are protected by
copyright, patent, trademark and/or other intellec-
tual property laws. Such content and services are
provided solely for your personal noncommercial
use. You may not use any content or services in

a manner that has not been authorized by the
content owner or service provider. Without limiting
the foregoing, unless expressly authorized by the
applicable content owner or service provider, you
may not copy, upload, post, transmit, translate,
sell, modify, create derivative works, or distribute
in any manner or medium any content or services
displayed through this device.

YOU EXPRESSLY ACKNOWLEDGE AND AGREE
THAT THE DEVICE AND ALL THIRD PARTY
CONTENT AND SERVICES ARE PROVIDED "AS
IS" WITHOUT WARRANTY OF ANY KIND, EI-
THER EXPRESS OR IMPLIED. LG ELECTRON-
ICS EXPRESSLY DISCLAIMS ALL WARRANTIES
AND CONDITIONS WITH RESPECT TO ANY
CONTENT AND SERVICES, EITHER EXPRESS
OR, IMPLIED, INCLUDING BUT NOT LIMITED
TO, WARRANTIES OF MERCHANTABILITY,

OF SATISFACTORY QUALITY, FITNESS FOR A
PARTICULAR PURPOSE, AND NON-INFRINGE-
MENT OF THIRD PARTY RIGHTS. LG DOES
NOT GUARANTEE THE ACCURACY, VALIDITY,
TIMELINESS, LEGALITY, OR COMPLETENESS
OF ANY CONTENT OR SERVICE MADE AVAIL-
ABLE THROUGH THIS DEVICE AND DOES NOT
WARRANT THAT THE DEVICE OR SERVICES
WILL MEET YOUR REQUIREMENTS, OR THAT

OPERATION OF THE DEVICE OR SERVICES
WILL BE UNINTERRUPTED OR ERROR-FREE.
UNDER NO CIRCUMSTANCES, INCLUD-

ING NEGLIGENCE, SHALL LG BE LIABLE,
WHETHER IN CONTRACT OR TORT, FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES, OR ANY OTHER
DAMAGES ARISING OUT OF, ANY INFORMA-
TION CONTAINED IN, OR ANY CONTENT OR
SERVICE ACCESSED BY YOU OR ANY THIRD
PARTY, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES.

Third party services may be changed, suspended,
removed, terminated or interrupted, or access may
be disabled at any time, without notice, and LG
makes no representation or warranty that any con-
tent or service will remain available for any period
of time. Content and services are transmitted by
third parties by means of networks and transmis-
sion facilities over which LG has no control. LG
may impose limits on the use of or access to cer-
tain services or content, in any case and without
notice or liability. LG expressly disclaims any re-
sponsibility or liability for any change, interruption,
disabling, removal of or suspension of any content
or service made available through this device.

LG is neither responsible nor liable for customer
service related to the content and services. Any
question or request for service relating to the
content or services should be made directly to the
respective content and service providers.
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LG Apps Function

This feature is not available for all country.

Additional applications can be downloaded from
the LG App Store.

These functions may be not available for a certain
period of time depending on country or set. In such
cases, the buttons may be disabled.

They are enabled when the services are available.

Sat. Jan. 1,201 12:00AM Geoocsoce  msin Ext
L] Premium B2 | LG Apps p

Hot
UCC Service

Movie Online

Weather Info

Photo Album

Social Network Service

Option Description

o Sign In Sign in or sign out to the

Sign Out premium service.
® |Exit Returns to TV viewing.
(3] Moves to LG Apps.

LG Apps Moves to the LG Apps you
(4] want directly.
@ |Search These functions may be not
® |Web Brower available for a certain period

of time depending on country
or set. In such cases, the but-
tons may be disabled.

They are enabled when the
services are available.

@ |Media Link

Stores the most frequently
used apps among all down-
loads. To change the list of
Quick Apps, see the "Using
My Apps".

® |Quick Apps.

Moves to My Apps.

You can browse all apps
installed, change the list of
Quick Apps, and select and
play the app you want.

© |My Apps

Registration LG Apps

1 Press Home to access the Home menu.

2 Press Red button to register.

- You can only register as a free member from
your TV.

3 Create your ID and password.
Press the Navigation buttons to select alphabet
and number and select OK.

4 The registration is completed.

0 NOTE

* If you wish to become a paid member or
change your information, please use your PC
and visit http://www.lgtvapp.com

Sign in with LG Apps account

To enjoy LG Apps with your account, you need
sign in with the LG Apps account.

1 Press Home to access the Home menu.

2 Press Red button to sign in.
It displays the keyboard menu for entering ID
and password.
- If you are not a member, press Red button
again. You can only register as a free mem-
ber from your TV.

3 Press the Navigation buttons to scroll to the
alphabet or number and press OK.

- If you check "Auto Sign In", you are automat-
ically logged in whenever you turn on TV.

4 Enjoy LG Apps.
You can enjoy Premium service, LG Apps, My
Apps and much more.

0 NOTE

* You can download a paid app on up to five
TVs.
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ID Management

1 After sign in, press Red button again.
A pop-up window will appears.

2 Press the Navigation buttons to scroll to the
desired menu option and press OK.

Account Setting

Change User

Sign Out

Close |

3 Manage the ID by using following menu.

Option Description
Check basic information, apps you
é::t?:nt purchased and apps installed on
9 your TV.
Change User | Changes your account.
Sign Out Sign out the premium service.

Using LG Apps

1 Press Home to access the Home menu.

2
3

Sign in on your TV.

Press the Navigation buttons to scroll to the LG
Apps and press OK.

Edit the Apps by using following menu.

Option Description
Lo Sign in or out to use the LG
@ |Sign in/out Apps.
@ |Search Search LG Apps.
© |My Apps Moves to My Apps.
@ |Back Move to the previous screen.
@ Exit Exit the LG Apps.
* Hot: Most downloaded apps
in the past 7 days
* New: Most recently released
apps
* Top Paid: Most downloaded
@ |Apps Sorting paid apps

* Top Free: Most downloaded
free apps

e ALL: Alphabetical order

* Moves to the previous or next
page using P A v button.

o

Apps Category

Shows the LG Apps category
(All, Game, Entertainment, Life,
Education, News/info.)

®

Live TV

Watches the current programme.
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34 ENTERTAINMENT

Purchasing and Installing Apps.

Log in first to purchase apps.

1 Press the Navigation buttons to select Apps
you want and press OK.
You can see the information of the App.

2 Press Purchase to buy a App.

00—

SUN
Final update date
2011172
Version 1.0
3 Mbyte

0Ratings
X %

= Ig2011 My Apps Back

| Horoscope
| Game

Option

Description

Sign in/out

Sign in or out to use the LG
Apps.

My Apps

Move to My Apps.

Back

Move to the previous screen.

App description

Shows the description of the
current Apps.

® 0P

Fee

Shows the fee of the current
app.

@ |Install

Install or purchase the App.
You can purchase an app on
either your PC or TV, but it
can be installed and played
only on the TV.

* If you want to purchase a
paid app, you need to sign
up as a paid member on
www.lgtvapp.com.

* If you don't have enough
available space on your TV,
you can download apps to
the USB storage device.

* You can play, delete or
move the apps stored on
the USB storage device
onto the My Apps screen.

@ [Rate this App

Rate the app you purchased
with stars.

® |App info.

Shows the information of the
current Apps.

0 NOTE

* To store apps in the USB storage device, make
sure that it is connected to the USB Apps port.

* Up to 1000 apps can be stored as USB apps.

* The USB storage device containing apps cannot be
used for storing other types of data.

J

Using My Apps

1 Enter the LG Apps after sign in.

2 Press the Navigation buttons to scroll to the My
Apps and press OK.

Description

Shows the amount of used and avail-
able memories.

Current page number/total number of
pages of My Apps.

Shows the downloaded apps.
Moves to the previous or next page using
P ~ v button.

Moves the LG Apps.

Quick Apps.

Sign In the LG Apps.
After sign in, manage the ID option (Ac-
count Setting, Change User, Sign Out).

Edit the My Apps.

Exit the My Apps.

Move to the Home menu.

eSS @ 90 @ ©

Delete the Apps.
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Smart Share Function

Connecting USB storage de-
vices

Connect USB storage devices such as a USB
flash drive or external hard drive to the TV and use
multimedia features (See "Browsing files").
Connect a USB flash drive or USB memory card
reader to the TV as shown in the following illustra-
tion.

USB Apps

o~
=
foe)
(7]
>
=
o
7]
=1

HDD IN

== ==
'\
!

¥

|

To disconnect a USB storage device, make sure to
end the connection properly to prevent damages
to the TV or files.

1 Press Q.MENU to access the quick menus.

2 Press the Navigation buttons to scroll to USB
Device and press OK.

3 Disconnect the USB storage device only when
the message says that it is safe to remove.

_/\ cAuTION N

* Do not turn the TV off or remove a USB stor-
age device while the USB storage device is
connected to the TV, as this could result in
loss of files or damage to the USB storage
device.

* Back up your files saved on a USB storage
device frequently, as you may lose or dam-
age the files and this may be not covered by
the warranty.

Tips for using USB storage devices

e The TV recognizes only a USB storage
device.

* If you connect a USB storage device to the
TV through a USB hub, your TV may not
recognize the USB storage device.

e The TV may not recognize a USB storage
device that requires a special driver.

¢ The recognition speed of a USB storage
device may differ depending on the device.

¢ Only use a USB storage device which has

normal music or image files.

Use only USB storage devices that are for-

matted as a FAT 32 or NTFS file system.

¢ You may need to connect a USB storage
device to an external power supply with a
power adapter.

¢ If the TV does not recognize a connected
USB storage device, replace the cable and
try again. Do not use an excessively long
cable.

e The TV does not support some USB storage
devices properly.

¢ You can use a multi-partition (up to 4) USB
storage device.

¢ You can use up to 4 USB storage devices at
a time by using a USB multi-card reader.

¢ The file alignment method of a USB storage
device is similar to the one of Window XP.

* You cannot create or delete a folder saved in
a USB storage device directly on the TV.

* The number of characters for a file name is
up to 100 English characters.

¢ Up to 1000 including folders and files can be
recognized.

* If there are too many folders and files in one
folder, it may not operate properly.

e The recommended capacity for a USB exter-
nal hard disk is 1 TB or less and for a USB
storage device is 32 GB or less.

* |If a USB external hard disk with the Energy
Saving feature does not work, turn the USB
external hard disk off and on again to make
it work properly. For more information, refer
to the user manual of the USB external hard
disk.

* USB storage devices below USB 2.0 are
supported as well. But they may not work
properly in the movie list.

* The electrostatic can cause USB device’s
malfunction. In this case, USB Device has to
be plugged again.
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36 ENTERTAINMENT

Connecting DLNA DMP (Digital
Living Network Alliance, Digital
Media Player)

This TV can display and play many types of movie,
photo and music files from your DLNA server and
has been certified by DLNA for movies, photos and
music.

The Digital Living Network Alliance (DLNA) is a
cross-industry organization of consumer electron-
ics, computing industry and mobile device compa-
nies. Digital Living provides consumers with easy
sharing of digital media through a wired or wireless
network in the home.

The DLNA certification logo makes it easy to find
products that comply with the DLNA Interoper-
ability Guidelines. This unit complies with DLNA
Interoperability Guidelines v1.5. When a PC run-
ning DLNA server software or other DLNA compat-
ible device is connected to this TV, some setting
changes of software or other devices may be
required. Please refer to the operating instructions
for the software or device for more information.
Please refer to "Smart Share Function" for addi-
tional information on supported file types and other
instructions.

,0 NOTE N

* The supplied Nero MediaHome 4 Essentials
CD-ROM is a customized software edition
only for sharing files and folders to this TV.

* The supplied Nero MediaHome 4 Essentials
software does not support following func-
tions: Transcoding, Remote Ul, TV control,
Internet services and Apple iTunes

* This manual explains operations with the
English version of Nero MediaHome 4 Es-
sentials as examples. Follow the explanation
referring to the actual operations of your
language version.

* If there are too many folders and files in one
folder, it may not operate properly.

* For the DLNA option, use the Nero Media-
Home programme that is provided with the
TV. However, we cannot guarantee that third
party programme will work perfectly.

You can select a programme while viewing
the small preview programme list on your TV
screen.

Check your network settings when the DLNA
option does not work properly.

If there is an abnormal operation or an er-
ror occurs in Nero Media Home, the DLNA
option may not work properly. In this case,
exit Nero Media Home and restart the
programme. You can download the latest
version of Nero Media Home by clicking

the question mark at the bottom-left of the
programme.

When the network is unstable, the device
may be slower or may need to load during
playback.

When playing a video in DLNA mode, the
Multi Audio and Closed Caption features are
not supported.

When selecting Full Screen in DLNA mode,
the ratio of the outputted screen may differ
from the original.

When more than one TV is connected to

a single server in DLNA mode, a file may
not play properly, depending on the server
performance.

If the server provides no information on a
specific file, it is displayed as "--".
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Installing Nero MediaHome 4 Essentials

Nero MediaHome 4 Essentials is an easy to use
DLNA server software for Windows.

Computer requirements for Nero MediaHome 4
Essentials

* Windows® XP (Service Pack 2 or higher),
Windows Vista® (no Service Pack re-
quired), Windows® XP Media Center Edition
2005 (Service Pack 2 or higher), Windows
Server® 2003 (Service Pack 1 or higher)

¢ Windows® 7 Home Premium, Professional,
Enterprise or Ultimate(32 and 64-bit)

¢ Windows Vista® 64-bit edition (application
runs in 32-bit mode)

* Windows® 7 64-bit edition (application runs
in 32-bit mode)

* Hard drive space: 200 MB hard drive space
for a typical installation of Nero MediaHome
stand-alone

¢ 1.2 GHz Intel® Pentium® Il or AMD Sem-
pron™ 2200+ processors

* Memory: 256 MB RAM

* Graphics card with at least 32 MB video
memory, minimum resolution of 800 x 600
pixels, and 16-bit colour settings

¢ Windows® Internet Explorer® 6.0 or higher

¢ DirectX® 9.0c revision 30 (August 2006) or
higher

* Network environment: 100 Mb Ethernet,
WLAN (IEEE 802.119g), or faster

Start up your computer.

2 Close all Microsoft Windows programmes and
exit any anti-virus software that may be run-
ning.

3 Insert the Nero MediaHome 4 Essentials CD-
ROM into your computer’s CD-ROM drive.

4 Click Nero MediaHome 4 Essentials. The
installation wizard will appear.

5 Click the Next button to display the serial
number input screen. Click Next to go to the
next step.

6 If you accept all conditions, click | accept the

License Conditions check box and click Next.

Installation is not possible without this agree-
ment.

7 Click Typical and click Next. The installation
process is started.

8 If you want to take part in the anonymous col-
lection of data, select the check box and click
the Next button.

9 Click the Exit button to complete the installa-
tion.

Sharing files and folders

After installing Nero MediaHome, you must add
folders you wish to share.

1 Double-click the Nero MediaHome 4 Essentials

icon on the desktop.

2 Click Network icon on the left and define your
network name in the Network name field. The
Network name you enter will be recognized by
your TV.

Click Shares icon on the left.
Click Local Folders tab on the Shared screen.

Click Add icon to open the Browse Folder win-
dow.

6 Select the folder containing the files you want
to share. The selected folder is added to the
list of shared folders.

7 Click Start Server icon to start the server.

p 0 NOTE N

* |f the shared folders or files are not displayed
on the TV, click the folder on the Local Fold-
ers tab and click Rescan Folder at the More
button.

e Visit http://www.nero.com for more informa-
tion and software tools.
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38 ENTERTAINMENT

Playing Shared Media

You can display and play movie, photo and music
content stored on your computer or other DLNA
media servers.

1
2

Press Home to access the Home menus.

Press the Navigation buttons to scroll to Smart
Share and press OK.

Press the Navigation buttons to scroll to the
device you want and press OK.

Press the Navigation buttons to select DLNA.

Depending on the media server, this TV may
need to get the permission from the server.

Tips for using DLNA DMP

To play the file on the media server, the TV
and the media server must be connected to
the same access point.

File requirements and playback functions on
the Smart Share may differ depending on the
media server used.

There may be some restrictions by file
features and the media server that restrict
playback.

Movie thumbnail is only supported when
DLNA server supports a Movie thumbnail.

If there is an unplayable music file in the
Smart Share menu, the TV will skip the file
and play next file.

Files in a folder can be played only when
they are of the same type.

The file information indicated on the screen
may not always correct for music and movie
files in Smart Share menu.

This TV only supports movie subtitle files
supplied by Nero MediaHome 4.

The subtitle file name and movie file name
have to be the same and located in the same
folder.

If subtitle files have been added after a direc-
tory has been indexed already, the user has
to remove and re-add the folder to the list of
shares.

The DRM/*.tp/*.trp file in DLNA server is not
played while Movie List is in operation.

MPO files are not played when Photo List is
in operation.

The playback and operating quality of the
Smart Share function may be affected by
your home network condition.

The files from removable media such as
USB drive, DVD-drive etc. on your media
server may not share properly.

When playing the Media through DLNA con-
nection, it does not support files protected by
DRM.

Up to 1000 including folders and files can be
recognized.

If there are too many folders and files in one
folder, it may not operate properly.
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Connecting DLNA DMR (Digital 0 NOTE ~

Living Network Alliance, Digital

Media Render) » Subtitle is supported only on some DMC
devices.

¢ The DMR function may not work properly in

This supports remote playing of media files. Media ’
a wireless network.

from a compatible device (Windows 7, Mobile .
Phone with PlayTo, or other compatible DLNA- * The seek function of the DMC only works on

DMC device) can be "pushed" to the TV. video files.
* The DMR is not available when another

function is operating (recording, playback or
Smart Share work etc.).
Refer to the owner’s manual of the mobile
phone or other device to find out how to use
1 To play afile, select the file by using the "Re- it to play a file.

mote Play" feature in Windows 7. * You can change the name of a connected
TV by double-clicking the item you want

The DMR function only works properly when the
TV and PC are on the same local network.

To do this, right-click on the file you want to to change in Control Panel > Network and
play. Internet > View network computers and
devices. (Only Windows 7)

2 You can play a file only on a single TV set or « You cannot change the name of a TV while
device even though multiple devices are con- DMR media is playing. Change it when play-
nected. The playback speed depends on the back is stopped.
network status. - /
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Picture display request from an external device.
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Browsing files

Access the photo, music or movie lists and browse

files.

1 Connect a USB storage device.

2 Press Home to access the Home menus.

3 Press the Navigation buttons to scroll to Smart
Share and press OK.

4 Press the Navigation buttons to scroll to the
device you want and press OK.

5 Press Navigation buttons to scroll to All Media,
Movie List, Photo List or Music List and
press OK.

- All Media: Shows all files in the file list.
- Movie List, Photo List or Music List:
Shows only one type of file in the file list.
6 Press Navigation buttons to select a folder or

file you want.

f
i Drive 1 !
)

f 3
Iﬂ . Change device I - Go o root folder I = Go to upper folder Wilext '.l @
1

Tips for using USB storage devices

Type

Supported file format

Video

* MPG, MPEG, DAT, TS, TRP, TP, VOD, MP4,

MOV, MKV, DivX, AVI, ASF, WMV

Max bitrate of playable movie file: 20 Mbps

(Mega bit per second)

Bit rate of audio format: within 32 kbps to

320 kbps (MP3)

* Supported subtitle format(external) :
*.smi, *.srt, *.sub(MicroDVD, SubView
1.0/2.0), *.ass, *ssa, *.txt(TMPlayer),
*.psb(PowerDivX)

» Supported subtitle format(internal) :
XSUB(Only, XSUB is the subtitle for-
mat used in DivX files), Text UTF- 8,
SRT,ASS,SSA(Only, this is the subtitle
format used in DivX-Plus HD files)

Description

Shows all media folders.

Current page number/total number of pages.

Moves to the previous or next page.

Photo

* Do not use the progressive option when
saving JPG files on your PC.

* It may take some time to open high-resolu-
tion images in full screen.

Current page number/total number of pages.

Files info or thumbnail.

Available buttons on the remote control.

OOO® ® |©F

Thumbnail information

File Item Profile
Exten-
sions
2D jpeg Suppro- |+ SOFO: baseline
ipg ted file |+ SOF1: Extend
jpe format Sequential
e SOF2: Progres-
sive
Photo * Min: 64 x 64
size * Max - Normal
Type: 15360 (W)
x 8640 (H)
* Progressive
Type: 1920 (W)
x 1440 (H)
3D mpo Sup- * mpo
(Only ported
3D file
mod- format
els) Photo | 4:3size:
size 3,648 x 2,736
2,592 x 1,944
2,048 x 1,536
o 3:2size:
3,648 x 2,432
Music | ¢ MP3

 Bit rate range 32 Kbps - 320 Kbps

* Sampling rate (Sampling Frequency)
MPEGH1 layer 3: 32 kHz, 44.1 kHz, 48 kHz
MPEG2 layer 3: 16 kHz, 22.05 kHz, 24 kHz
* A copy-protected file will not play.

Type Abnormal files Non-supported files

Video

Photo

Music
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3D IMAGING (ONLY
3D MODLES)

3D Technology

TV near fragile objects or near any objects
that can be knocked over easily.

Please prevent children under the age of 5
from watching 3D TV. It may affect their vi-
sion development.

Warning for photosensitization seizure:
Some viewers may experience a seizure or
epilepsy when exposed to certain factors,
including flashing lights or images in TV or

This TV can display in 3D via 3D broadcasting or
when the TV is connected to a compatible device,

video games. If you or anybody from your
family has a history of epilepsy or seizure,

such as a Blu-ray 3D Player. The viewer must

wear compatible 3D glasses in order to see these

images in 3D format.

4\ WARNING

* When watching 3D images, you should

maintain a distance of at least twice the
screen width, and you should also be able
to see all of the screen at eye level. The 3D
imaging may not display if it is viewed while
you are lying down.

It may take a moment for you to see the

3D imaging if you look away from the TV
and then revert your eyes back to the 3D
programme.

To watch the TV in 3D, you must put on your
3D glasses. For best results, you should
wear LG Brand 3D glasses. The 3D imaging
may not display properly when using another
brand of 3D glasses. Please see the 3D
glasses manual for instructions on how to
use the 3D glasses.

When watching 2D images, it is recommend-
ed to take off the 3D glasses. If you watch
2D images with the 3D glasses on, you may
see distorted images.

If you watch the 3D imaging too closely or
for a long period of time, it may harm your
eyesight.

Watching the TV or playing video games that
incorporate 3D imaging with the 3D glasses
for a long period of time can cause drowsi-
ness, headaches or fatigue to you and/or
your eyes. If you have a headache, or other-
wise feel fatigued or drowsy, stop watching
the TV and have a rest.

Pregnant woman, seniors, persons with
heart problems or persons who experience
frequent drowsiness should refrain from
watching 3D TV.

Some 3D imaging may cause you to duck

or dodge the image displayed in the video.
Therefore, it is best if you do not watch 3D

please consult with your doctor before
watching 3D TV.

Also certain symptoms can occur in unspeci-
fied conditions without any previous history.
If you experience any of the following symp-
toms, immediately stop watching the 3D
imaging and consult a doctor: dizziness or
light-headedness, visual transition or altered
vision, visual or facial instability, such as eye
or muscle twitching, unconscious action,
convulsion, loss of conscience, confusion

or disorientation, loss of directional sense,
cramps, or nausea. Parents should monitor
their children, including teenagers, for these
symptoms as they may be more sensitive to
the effects of watching 3D TV.

Risk of photosensitization seizure can be
reduced with the following actions.

» Take frequent breaks from watching 3D
TV.

» For those who have vision that is differ-
ent in each eye, they should watch the TV
after taking vision correction measures.

» Watch the TV so that your eyes are on the
same level as the 3D screen and refrain
from sitting too closely to the TV.

» Do not watch the 3D imaging when tired
or sick, and avoid watching the 3D imag-
ing for a long period of time.

» Do not wear the 3D glasses for any other
purpose than viewing 3D imaging on a 3D
TV.

» Some viewers may feel disoriented after
watching 3D TV. Therefore, after you
watch 3D TV, take a moment to regain
awareness of your situation before mov-

ing.
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— @) NoTE N

(Only 47/55LW77++, 47/55LW95++, 47/55L.Z296++)

» After powering on the TV, a few seconds
may be needed for your TV to calibrate.

* [f there is an obstacle between the TV and
the 3D glasses, the 3D imaging may not
display properly.

* Do not use the TV in close proximity to other

electronic equipments and RF equipments.
N J

NOTE

(Only 42/47L\W57++, 42/47/55L\W65+*)
* After powering on the TV, a few seconds
may be needed for your TV to calibrate.

When using 3D Glasses

_/\ cAuTION N

* Do not use the 3D glasses to replace your
corrective glasses, sunglasses or protective
goggles.

* Do not store the 3D glasses in hot or cold
locations.

* Do not drop objects onto the 3D glasses. Do
not drop or bend the glasses.

» Since the lenses of the 3D glasses are
easily scratched, make sure to clean only
with a soft cloth. Shake off any dust before
using the cloth since the glasses are easily
scratched.

* A communication failure may occur if the
glasses are near electronic devices that use
the same bandwidth (2.4 GHz), such as a
microwave oven or wireless LAN product.

3D Imaging viewing range

(Only 47/55LW7 7+, 47/55L\W95+**, 47/55L.Z96++)
TV size, viewing angle & other circumstances may
change the viewing distance and the angle of view.

Maximum Viewing Dis-
tance

2mto7m 10m

Viewing Distance

Viewing 3D Imaging

Play the video produced in 3D.
Press 3D to watch 3D imaging.

Wear the 3D glasses.

A W N -

Press the Navigation buttons to scroll the OK
and press OK.

5 Press the Navigation buttons to scroll to the
shape and press OK. (See "3D supported

mode")
Mode Description
2D » 3D Changed from 2D imaging to
3D imaging.
GD),
Side by Side

Top & Bottom

Checker Board

Frame Sequential

s

6 Press 3D button to 2D Off or 3D Off.

Option Description
3D 2D Displays images in 2D without
any 3D effects.
3D Off Displays images in original
format.
2D - 3D Displays images in 3D.
Cancel Close the pop-up window.
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Setting 3D Imaging

1 Press the 3D OPTION while viewing 3D
imaging. A pop-up window will appears.

2 Press the Navigation buttons to scroll to one
of the following options and press OK.

Choose options.

3D Mode Setting

Set Video.

Set Audio.

| Previous | | Close |

3D Mode Setting
Option Description
(Depending on
model)
:\;l"oa(?ee View Selects “2D — 3D” or “3D — 2D".

3D Picture Size

Cuts off the outer edges of the
picture and stretch it to fit the full
screen in 3D mode.

Select Left/Right or Right/Left.

g?)rl:;ittlij;i Select the screen with 3D video
with bettter visibility.
Adjusts the stereoscopic effect of
3D Depth the 3D image converted from a 2D
image.
Moves the 3D image to the front
3D Viewpoint and back to adjust the 3D perspec-
tive view.
: Adjusts the colour and brightness
3D Picture . h
Balance difference between the right and

left sides of the picture in 3D mode.

3D Optimization

Optimizes the 3D image screen for
the viewing environment.

Set Video.

Allows you to change Video settings. (Refer to
“PICTURE Settings”).

Set Audio.

Allows you to change Audio settings. (Refer to
“AUDIO Settings”).

_/\ cAuTION N

* Some menus may not work while viewing 3D
imaging.

* The 3D imaging mode is disabled automati-
cally when switching DTV channels, input
source.

* The screen may not be displayed properly if
you view 2D images in 3D imaging mode.

» 3D effect can be seen when 3D Mode is
selected appropriately for the 3D input signal
supplied to the TV.

* For *mpo files (3D camera files), the 3D
imaging mode is enabled automatically.

0 NOTE ~

* If you select 3D mode, “Power indicator” is
turned off automatically.

* You can only choose “Off or Cinema” with
the AV MODE button on the remote control.

* Energy Saving is disabled while playing in
3D.

e You cannot enter the Home menu while
watching 3D files.
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3D supported mode

: q Horizontal Vertical :
Input Signal Resolution Freqt?grfg}r) (kHz) Frequ?ar:g? (Hz) Playable 3D video format
45 60 Top & Bottom, Side by Side,
HDMI 3D Top & Bottom
720 1280720 89.9/90 59.94/60 HDMI 3D Frame Packing
X
P 375 Top & Bottom, Side by Side,
’ 50 HDMI 3D Top & Bottom
75 HDMI 3D Frame Packing
33.75 60 . .
: Top & Bottom, Side by Side,
1080i 1920X1080 28.125 50 HDMI 3D Side by Side (Half)
Top & Bottom, Side by Side,
HDMI 67.50 60 Checker Board,
Single Frame Sequential
Top & Bottom, Side by Side,
56.250 50 Checker Board,
Single Frame Sequential
1080p 1920X1080 Top & Bottom, Side by Side,
27 24 Checker Board,
HDMI 3D Top & Bottom
53.95/54 23.98/24 HDMI 3D Frame Packing
e 67.50 30 HDMI 3D Frame Packing
@ To i i
p & Bottom, Side by Side,
5) 33.75 30 Checker Board
I
RGB 1080p 1920X1080 66.587 59.934 Top & Bottom, Side by Side
USB 1080p 1920X1080 33.75 30 Jop g(goétgga?ﬁSg{Pﬁfti')
DNLA 1080p 1920X1080 33.75 30 Top & Bottom, Side by Side
Signal Playable 3D video format
DTV 720p, 1080i Top & Bottom, Side by Side

* Media contents and a player need to support HDMI 3D Frame Packing, HDMI 3D Side by Side, HDMI
3D Top & Bottom to play in 3D.

* Video, which is input as HDMI 3D Frame Packing, HDMI 3D Side by Side, HDMI 3D Top & Bottom
format, is switched into the 3D screen automatically.
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MAKING CONNECTIONS

Connect various external devices to the TV and switch input modes to select an external device. For more
information on external device’s connection, refer to the manual provided with each device.

Available external devices are: HD receivers, DVD players, VCRs, audio systems, USB storage devices,
PC, gaming devices, and other external devices.

0 NOTE ~

« If you record a TV programme on a DVD recorder or VCR, make sure to connect the TV
signal input cable to the TV through a DVD recorder or VCR. For more information on
recording, refer to the manual provided with the connected device.

¢ The external device connection may differ from the model.

» Connect external devices to the TV regardless of the order of the TV port.

= /)

Connecting your Unit

¢ Image shown may differ from your TV.
» To connect additional equipment, see the MAKING CONNECTIONS section in CD Manual.

USB Connection
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TROUBLESHOOTING

General

Problem

Resolution

Cannot control the TV with the
remote control.

Check the remote control sensor on the product and try again.

Check if there is any obstacle between the product and the remote control.
Check if the batteries are still working and properly installed (@ to @, Oto @).
Check if the appropriate input mode such as TV or VCR is set for using the
remote control.

No image display and no sound is
produced.

Check if the product is turned on.
Check if the power cord is connected to a wall outlet.
Check if there is a problem in the wall outlet by connecting other products.

Image appears slowly when the TV
turns on.

The image is muted during the product stat up process. This is normal. If the
image does not appear in a few minutes, unplug the TV for 30 seconds and try
again. If the image still does not appear, contact the authorized service centre
in your local area.

Cannot connect external devices.

Refer to the “Connection overview” and connect an external device.

The TV turns off suddenly. * Check the power control settings. The power supply may be interrupted.
* Check if the Auto sleep feature is activated in the Time settings.
Refer to the “Sleep Timer”.
* If there is no signal while the TV is on, the TV will turn off automatically after 15
minutes of inactivity.
Audio
Problem Resolution

No sound is produced while images
are displaying.

Press A+ or - button.

Check if the sound is muted by pressing MUTE.

Scroll to other channels. There may a problem with the broadcast.
Check if the audio cables are connected properly.

Check if the TV Speaker feature is activated in the menu option.

No output from one of the speakers

Adjust Balance in the menu option.

Unusual sound from inside the TV
is produced.

A change in ambient humidity or temperature may result in an unusual noise
when the product turns on or off. There is no problem with your product.

Video

Problem

Resolution

An image displays in black and
white or the colour quality is poor.

Adjust the colour setting in the menu option.
Keep a sufficient distance between this product and other electronic products.
Scroll to other channels. There may a problem with the broadcast.

Horizontal or vertical bars appears
or images blur

Check if there is local interference such as an electrical appliance or power
tool.

Lines or streaks appear on images

Check the antenna or aim the antenna to the correct direction.

Afterimages (ghosts) appear when
the product turns off

Pixels may have been damaged from a fixed image displayed for a long time
(image burn). Use a screen saver to prevent the pixel damage on the screen.

The power is on but the screen ap-
pears extremely dark.

Adjust the brightness and contrast in the menu option.

“No Signal” appears on the screen.

Check if the signal cable is connected between the TV and products properly.
Check the selected input source by pressing INPUT.

Black spots appear on the screen.

Several pixels in red, green, white, or black may appear on the screen that can
attribute to the characteristics of the LCD panel.
This is normal.

The display offset is wrong.

Adjust the position setting in the menu option.

Check if the video card resolution and frequency are supported by the product.
If the frequency is out of range, set to the recommended resolution using the
display settings on the external device.

Thin lines appear in the background
of the screen.

Check the video cable connections.

Horizontal noises appear or charac-
ters blur.

Adjust the Phase setting in the menu menu.
Refer to the “SCREEN”.

The reception on some channels
is poor

Scroll to other channels. There may a problem with the broadcast.

The station signal may be weak. Aim the antenna to the correct direction.
Check if there is local interference such as an electrical appliance or power
tool.
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OPEN SOURCE SOFTWARE NOTICE

» To obtain the corresponding source code under GPL, LGPL, MPL and other open source licenses, please visit http://
opensource.lge.com/. All referred license terms, warranty disclaimers and copyright notices are available to download
with the source code.

SPECIFICATIONS

32LV37++ 42LV37+*
MODELS 32LV3710-TB 421V3710-TB
32LV3730-TD 421V3730-TD
32LV370S-TC 421V370S-TC
Dimensions | With stand 764 mm x 545 mm x 240 mm 998 mm x 684 mm x 256 mm -
(WxHxD) |Wwithout stand 764 mm x 484 mm x 35 mm 998 mm x 615 mm x 30 mm %
_ With stand 11.2kg 15.5 kg =
Weight - I
Without stand 9.4 kg 13.3kg
Power requirement AC 100-240 V~ 50/ 60 Hz AC 100-240 V~ 50/ 60 Hz
47LV37**
MODELS 47LV3710-TB
471.V3730-TD
47LV370S-TC
Dimensions With stand 1108 mm x 746 mm x 256 mm
(WxHxD) | without stand 1108 mm x 677 mm x 30.4 mm
) With stand 20.9 kg
Weight -
Without stand 18.7 kg

Power requirement AC 100-240 V~ 50/ 60 Hz

Product specifications shown above may be changed without prior notice due to upgrade of product
functions.
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48 SPECIFICATIONS

32LV55# 37LV55+*
MODELS
32LV5500-TA 37LV5500-TA
Dimensions | With stand 776 mm x 549 mm x 240 mm 896 mm x 617 mm x 240 mm
(WxHxD) |Without stand 776 mm x 485 mm x 34.9 mm 896 mm x 553 mm x 34.9 mm
) With stand 10.8 kg 12.6 kg
Weight -
Without stand 8.8 kg 10.8 kg
Power requirement AC 100-240 V~ 50/ 60 Hz AC 100-240 V~ 50/ 60 Hz
42LV55+ 47LV55+*
MODELS
421V5500-TA 47LV5500-TA
Dimensions With stand 1012 mm x 683 mm x 256 mm 1121 mm x 746 mm x 256 mm
(WxHxD) | without stand 1012 mm x 617 mm x 29.9 mm 1121 mm x 678 mm x 29.9 mm
. With stand 15.5kg 20.7 kg
Weight -
Without stand 13.2kg 18.4 kg

Power requirement

AC 100-240 V~ 50/ 60 Hz

AC 100-240 V~ 50/ 60 Hz

55LV55++

MODELS
55LV5500-TA
Dimensions | With stand 1298 mm x 849 mm x 338 mm
(WxHxD) |without stand 1298 mm x 778 mm x 29.9 mm
. With stand 25.8 kg
Weight -
Without stand 21.7 kg

Power requirement

AC 100-240 V~ 50/ 60 Hz

Product specifications shown above may be changed without prior notice due to upgrade of product

functions.
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42L W57+ 47LW57
MODELS
42LW5700-TA 47LW5700-TA
Dimensions | With stand 999 mm x 681 mm x 255 mm 1109 mm x 744 mm x 255 mm
(WxHxD) | without stand 999 mm x 623 mm x 30.9 mm 1109 mm x 684 mm x 30.9 mm
. With stand 15.7 kg 20.2 kg
Weight -
Without stand 13.4 kg 17.9kg

Power requirement

AC 100-240 V~ 50/ 60 Hz

AC 100-240 V~ 50 /60 Hz

421 W65+ 47LW65+*
MODELS 42LW6500-TA 47LW6500-TA
421\W6510-TB 47LW6510-TB
Dimensions With stand 1009 mm x 686 mm x 255 mm 1119 mm x 749 mm x 255 mm
(WxHxD) | without stand 1009 mm x 622 mm x 29.9 mm 1119 mm x 684 mm x 29.9 mm
. With stand 16.2 kg 21.0kg
Weight -
Without stand 13.4 kg 18.2 kg
Power requirement AC 100-240 V~ 50/ 60 Hz AC 100-240 V~ 50/ 60 Hz
55LW65+*
MODELS 55LW6500-TA
55LW6510-TB
Dimensions | With stand 1297 mm x 851 mm x 341 mm
(WxHxD) |Without stand 1297 mm x 785 mm x 29.9 mm
. With stand 27.0kg
Weight -
Without stand 22.0 kg

Power requirement

AC 100-240 V~ 50/ 60 Hz

Product specifications shown above may be changed without prior notice due to upgrade of product

functions.
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50 SPECIFICATIONS

4TLWT 7 55LW77*
MODELS
47LW7700-TA 55LW7700-TA
Dimensions With stand 1114 mm x 747 mm x 263 mm 1291 mm x 860 mm x 347 mm
(WxHxD) | without stand 1114 mm x 680 mm x 31.1 mm 1291 mm x 780 mm x 31.1 mm
. With stand 23.7kg 33.4 kg
Weight -
Without stand 20.9 kg 28.2 kg

Power requirement

AC 100-240 V~ 50/ 60 Hz

AC 100-240 V~ 50/ 60 Hz

47LW95+ 55LW95*x
MODELS
47L.W9500-TA 55LW9500-TA
Dimensions With stand 1095 mm x 735 mm x 235 mm 1265 mm x 831 mm x 285 mm
(WxHXD) | \ithout stand 1095 mm x 665 mm x 27.5 mm 1265 mm x 760 mm x 27.5 mm
) With stand 22.5kg 29 kg
Weight -
Without stand 18.2 kg 23.8 kg

Power requirement

AC 100-240 V~ 50/ 60 Hz

AC 100-240 V~ 50/ 60 Hz

47LZ96+ 55LZ296+**
MODELS
471L.Z9600-TA 55LZ9600-TA
Dimensions With stand 1069 mm x 722 mm x 307 mm 1242 mm x 819 mm x 307 mm
WXHXD) | \without stand 1069 mm x 627 mm x 19.8 mm 1242 mm x 725 mm x 20.5 mm
) With stand 20.6 kg 25.0 kg
Weight -
Without stand 11.9kg 16.3 kg

Power requirement

AC 100-240 V~ 50/ 60 Hz

AC 100-240 V~ 50/ 60 Hz

Environment
condition

Operating Temperature 0°Cto40°C

Operating Humidity Less than 80 %
Storage Temperature -20 °C to 60 °C
Storage Humidity Less than 85 %

Product specifications shown above may be changed without prior notice due to upgrade of product

functions.

For the power supply and power consumption, refer to the label attached to the product.




SPECIFICATIONS

51

Digital TV Analogue TV
New Zealand, Singapore | gjeyision System DVB-T PAL/SECAM-B/G/D/K, PAL-|
BG : VHF/UHF 1 to 69, CATV 01 to 47
Programme Coverage UHF 21 to 69 | : VHF/UHF 1 to 69, CATV 01 to 47
DK : VHF/UHF 1 to 69, CATV 01 to 47
Australia Television System DVB-T PAL B/B
VHF 06 to 12,
Programme Coverage B/B : VHF/UHF 0 to 75, CATV : 2 to 44
UHF 27 to 69
Indonesia, Israel Television System DVB-T PAL/SECAM-B/G/D/K, PAL-I, NTSC-M
BG : VHF/UHF 1 to 69, CATV 01 to 47
| : VHF/UHF 1 to 69, CATV 01 to 47
Programme Coverage UHF 21 to 69
DK : VHF/UHF 1 to 69, CATV 01 to 47
M : VHF/UHF 2 to 78, CATV 01 to 71
South Africa Television System DVB-T PAL/SECAM-B/G/D/K, PAL-l, NTSC-M

Programme Coverage

VHF 4 to 11, 13
UHF 21 to 68

BG : VHF/UHF 1 to 69, CATV 01 to 47
| : VHF/UHF 1 to 69, CATV 01 to 47
DK : VHF/UHF 1 to 69, CATV 01 to 47
M : VHF/UHF 2 to 78, CATV 01 to 71

Veitnam, Malaysia

Television System

Programme Coverage

DVB-T

PAL/SECAM-B/G/D/K, PAL-l, NTSC-M

VHF 6 to 12,
UHF 21 to 69

BG : VHF/UHF 1 to 69, CATV 01 to 47
| : VHF/UHF 1 to 69, CATV 01 to 47
DK : VHF/UHF 1 to 69, CATV 01 to 47
M : VHF/UHF 2 to 78, CATV 01 to 71

Iran

Analogue model

Television System

Programme Coverage

Television System

Programme Coverage

External Antenna
Impedance

DVB-T

PAL/SECAM-B/G/D/K, PAL-l, NTSC-M

VHF 5 to 12,
UHF 21 to 69

BG : VHF/UHF 1 to 69, CATV 01 to 47
| : VHF/UHF 1 to 69, CATV 01 to 47
DK : VHF/UHF 1 to 69, CATV 01 to 47
M : VHF/UHF 2 to 78, CATV 01 to 71

PAL/SECAM-B/G/D/K, PAL-l, NTSC-M

BG : VHF/UHF 1 to 69, CATV 01 to 47
| : VHF/UHF 1 to 69, CATV 01 to 47
DK : VHF/UHF 1 to 69, CATV 01 to 47
M ;. VHF/UHF 2 to 78, CATV 01 t0.71

75 Q

75 Q

Product specifications shown above may be changed without prior notice due to upgrade of product

functions.

For the power supply and power consumption, refer to the label attached to the product.
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@ LG

An extended Owner's Manual that contains
information on the advanced features of these
LG TV sets is located on the CD- ROM provided
in an electronic version.

To read these files, you will need to use a
Personal Computer (PC) equipped with a CD-
ROM drive.

Record the model number and serial
number of the TV.

Refer to the label on the back cover and
quote this information to your dealer when
requiring any service.

Model :

Serial No. :

Life's Good

(Only DTV)

Digital Video
Broadcasting

Trade Mark of the DVB Digital Video
Broadcasting Project (1991 to 1996)
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